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NEW QUESTION 1
True or False: A reference line cannot be added from the Analytics Pane

A. True
B. False

Answer: B

Explanation: 
 You can add a reference line to any continuous axis in the view. To add a reference line:
Drag Reference Line from the Analytics pane into the view. Tableau shows the possible destinations. The range of choices varies depending on the type of item
and the current view.
In a simple case, the drop target area offers three options:

Reference: https://help.tableau.com/current/pro/desktop/en-us/reference_lines.htm

NEW QUESTION 2
If you have a dashboard and are displaying its filter, how can you rearrange it?

A. By clicking on the 2 lines on top and dragging the filter.
B. By clicking on the dropdown and dragging the filter
C. By clicking on the filter title and dragging it.
D. By clicking anywhere inside the filter and dragging it.

Answer: A

Explanation: 
You can drag the filter by clicking on the 2 lines on top, and then dragging the filter as shown:

NEW QUESTION 3
By definition, Tableau displays measures over time as a ______

A. Packed Bubble
B. Bar
C. Stacked Bar
D. Line

Answer: D

Explanation: 
 Line charts connect individual data points in a view. They provide a simple way to visualize a sequence of values and are useful when you want to see trends over
time, or to forecast future values.
Please refer to the images below:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/buildexamples_line.htm

NEW QUESTION 4
When creating a histogram in Tableau, to what does bin size refer?

A. The minimum number of axis ticks in the view.
B. The range of the continuous measure counted in each bin.
C. The count distinct (COUNTD) of items on either axis.
D. The maximum number of marks in the view.

Answer: B

Explanation: 
 When creating a histogram in Tableau, bin size refers to the range of the continuous measure counted in each bin. A histogram is a chart that displays the shape
of a distribution of a continuous measure. A histogram looks like a bar chart but groups values for a continuous measure into ranges, or bins. The basic building
blocks for a histogram are as follows: Mark type: Automatic; Rows shelf: Continuous measure (aggregated by Count or Count Distinct); Columns shelf: Bin
(continuous or discrete)4 To create bins from a continuous measure, you need to specify the size of bins, which determines how many bins are created and how
wide they are. The size of bins is equal to the difference between consecutive values along the axis that represents the bins. For example, if you have bins with
values 0-10, 10-20, 20-30, etc., then the size of bins is 10. You can either enter a value for the size of bins manually or have Tableau suggest an optimal bin size
based on a formula that considers the number of distinct rows and the minimum and maximum values in the data5 The other options are not valid definitions of bin
size when creating a histogram in Tableau. The minimum number of axis ticks in the view is determined by Tableau’s automatic scaling and formatting of axes,
which can be adjusted manually if needed. The count distinct (COUNTD) of items on either axis is an aggregation function that returns the number of unique
values in a field, which can be used as a measure in a histogram but not as bin size. The maximum number of marks in the view is limited by the performance and
readability of the visualization, which can be improved by filtering, sorting, or aggregating the data4

NEW QUESTION 5
A _______ is a single zip file that contains a workbook along with any supporting local file data and background images. This format is the best way to package
your work for sharing with others who don’t have access to the original data.

A. .twbx file
B. .tbm file
C. .twb file
D. .tde file

Answer: A

Explanation: 
According to the official Tableau documentation:
Tableau packaged workbooks have the .twbx file extension. A packaged workbook is a single zip file that contains a workbook along with any supporting local file
data and background images. This format is the best way to package your work for sharing with others who don’t have access to the original data. For more
information, see Packaged Workbooks.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 6
You can create ______ for members in a dimension so that their labels appear differently in the view.

A. parameters
B. duplicates
C. copies
D. aliases

Answer: D

Explanation: 
 You can create aliases (alternate names) for members in a dimension so that their labels appear differently in the view.
Aliases can be created for the members of discrete dimensions only. They cannot be created for continuous dimensions, dates, or measures.
To create an alias:

1) In the Data pane, right-click a dimension and select Aliases.
2) In the Edit Aliases dialog box, under Value (Alias), select a member and enter a new name.

? To submit your changes: In Tableau Desktop, click OK.
On Tableau Server or Tableau Online, click the X icon in the top-right corner of the dialog box.
When you add the field to the view, the alias names appear as labels in the view. For example:
Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_fieldproperties_aliases_ex1editing.htm

NEW QUESTION 7
To connect Tableau to a CSV data source what type of connection should you use?

A. Spatial
B. Excel
C. Text
D. JSON

Answer: C

Explanation: 
 Tableau recognises a CSV file as a TEXT file, and therefore it is the correct option. The following are the steps to import a CSV file:
1) From the data connection screen, click on Text:
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2) Choose the appropriate file, and click Open:

3) Finally, Tableau imports the data as shown below:

Reference: https://intellipaat.com/community/46338/how-to-import-csv-file-in-tableau

NEW QUESTION 8
Which of the following lets you group related dashboard items together so you can quickly position them?

A. Layout Extensions
B. Layout Blanks
C. Layout Containers
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D. Layout positioners

Answer: C

Explanation: 
Layout containers let you group related dashboard items together so you can quickly position them. As you change the size and placement of items inside a
container, other container items automatically adjust

Reference: https://help.tableau.com/current/pro/desktop/en- us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 9
Suppose I have the following view. What will be the total number of marks if I drag a new measure to the row shelf vs the column shelf?

A. If dragged to row shelf : 14 marks ; If dragged to column shelf : 7 marks
B. If dragged to row shelf : 7 marks ; If dragged to column shelf : 14 marks
C. If dragged to row shelf : 14 marks ; If dragged to column shelf : 14 marks
D. If dragged to row shelf : 7 marks ; If dragged to column shelf : 7 marks

Answer: A

Explanation: 
 This is a tricky question often asked in the exam.
If we drag a new measure to the row shelf, the following happens:
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We now have 2 rows, and the same 7 columns for both these rows. Therefore, 2x7 = 14 marks!

But if we drag the same measure to the column shelf, we have just 1 row and a chart created for each of the columns. So (1x7) = 7 marks!

Reference and notes: https://medium.com/@justindixon91/tableau-specialist-exam-notes- part-4-understanding-tableau-concepts-f78de83fdd35

NEW QUESTION 10
True or False: We can disaggregate the data, to see all of the marks in the view at the most detailed level of granularity

A. True
B. False

Answer: A

Explanation: 
 Whenever you add a measure to your view, an aggregation is applied to that measure by default. This default is controlled by the Aggregate Measures setting in
the Analysis menu. If you decide you want to see all of the marks in the view at the most detailed level of granularity, you can disaggregate the view.
Disaggregating your data means that Tableau will display a separate mark for every data value in every row of your data source.
To disaggregate all measures in the view:
Clear the Analysis >Aggregate Measures option. If it is already selected, click Aggregate Measures once to deselect it.

Reference: https://help.tableau.com/current/pro/desktop/en- us/calculations_aggregation.htm
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NEW QUESTION 10
What are three ways to access bolding options for the text in a tooltip? Choose three.

A. Select Tooltip on the Marks card.
B. Select Format on the menu, and then select Font
C. Select Worksheet on the menu, and then select Tooltip
D. Hover over a mark and press CTRL+B.
E. Hover over a mark and press ALT+F.
F. Right-click on the Field and select Format.

Answer: ACF

Explanation: 
 To access bolding options for the text in a tooltip in Tableau, you can:
? Select Tooltip on the Marks card, which allows you to edit the tooltip for the specific marks.
? Select Worksheet on the menu, and then Tooltip, to open the tooltip editor for the worksheet.
? Right-click on the Field and select Format, which lets you format the text including bolding options in the tooltip.

NEW QUESTION 12
Tableau auto-generates ______ dimension(s) and ______ measure(s) for us

A. 1 , 4
B. 2 , 2
C. 2 , 3
D. 1 , 2

Answer: A

Explanation: 
 Tableau auto-generates :
1 Dimension - Measure Names
4 Measures - Latitude, Longitude, Number of records, Measure Values
Starting with Tableau 2020.2, every table in a data source has a Count field, in the form of NameofTable(Count). The table count field is an automatically
generated, calculated field. (THIS IS NOT PRESENT IN VERSION 2020.1 ON WHICH THE EXAM IS CURRENTLY BASED)
Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_understanddatawindow.htm

NEW QUESTION 14
A Tableau Support case can be opened in which of the following valid ways?

A. Using the Developer Community Forum
B. Contacting Salesforce using their website
C. Using the support option on the Tableau website
D. Using the Tableau learn website

Answer: C

Explanation: 
 It is possible to open a Tableau support case by visiting the following link : https://www.tableau.com/support/case

NEW QUESTION 18
Our use case states that we need to create a set showing the Bottom 10 products by Profit in each Region. Which of the following filter types should you apply on
Region?

A. Measure Filters
B. Context Filters
C. Extract Filters
D. Dimension Filters

Answer: B

Explanation: 
The beauty of context filters is that according to Tableau's Order of Operations, they are executed before Sets.

This means that based on what Region's you've selected - Tableau will first only preserve the rows for those Regions. THEN, after this it will compute the Set , i.e ,
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Bottom 10 products in each Region.
1) First let's create a set to compute the Bottom 10 Products by Profit.

2) Next, take region on the Rows Shelf followed by the Set we just created. Drag Region and the Set to the Filters Shelf as well.

3) Now, try to only visualize the data for the South Region:

4) The problem right now is that Tableau is computing the Set first (Bottom 10 Products), and then applying the Dimension Filter - South Region and hence these
values are incorrect. Note how these aren't even 10 products, but rather just 8. To fix this, simply add Region to Context:
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Upon doing this, we get the correct answer as :

References: https://help.tableau.com/current/pro/desktop/en-us/order_of_operations.htm https://help.tableau.com/current/pro/desktop/en-us/filtering_context.htm

NEW QUESTION 22
How do you identify a continuous field in Tableau?

A. It is identified by a blue pill in the visualization
B. It is identified by a green pill in a visualization
C. It is preceded by a '=#' symbol in the data window
D. It is preceded by a 'Abc' symbol in the data window

Answer: B

Explanation: 
 When you connect to a new data source, Tableau assigns each field in the data source as dimension or measure in the Data pane, depending on the type of data
the field contains. You use these fields to build views of your data.

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 23
You view the relationship canvas shown in the following exhibit.

What does Migrated Data indicate?

A. The workbook was created in previous version of Tableau Desktop.
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B. The data was imported from Tableau Server.
C. The data was recently saved as a packaged data source.
D. The workbook was downloaded from Tableau Online.

Answer: A

Explanation: 
 In the context of Tableau, "Migrated Data" typically refers to data or workbooks that have been upgraded from a previous version of Tableau Desktop. When you
open a workbook in a newer version of Tableau, the data sources within that workbook might be labeled as "Migrated Data," indicating that they have undergone a
conversion process to be compatible with the new version's features and architecture.

NEW QUESTION 24
Which statement accurately describes aliases?

A. You can create an alias for a discrete measure.
B. You can create an alias for a continuous dimension.
C. When you assign an alias, the name changes in the database.
D. You can assign an alias to a field member before creating a visualization.

Answer: D

Explanation: 
 You can assign an alias to a field member before creating a visualization. An alias is an alternative name that you can assign to a value in a dimension field. You
can use aliases to rename specific values within a dimension to make them more relevant or descriptive in your view than what the original data provides. For
example, you can use aliases to shorten long names, correct spelling errors, or replace codes with meaningful labels6 You can create aliases for the members of
discrete dimensions only. They cannot be created for continuous dimensions, dates, or measures. To create an alias for a dimension member, you can right-click
the dimension in the Data pane and select Aliases, then enter a new name for each member under Value (Alias). You can also create an alias by right-clicking a
dimension member in the view and selecting Edit Alias. You can do this before or after creating a visualization6 The other options are not accurate statements
about aliases. You cannot create an alias for a discrete measure, because measures are not discrete fields. You cannot create an alias for a continuous
dimension, because aliases are only available for discrete dimensions. When you assign an alias, the name does not change in the database, only in Tableau.
Aliases are stored as part of the workbook or data source, and do not affect the original data6

NEW QUESTION 29
What is the minimum amount of RAM recommended for any production use of Tableau
Server?

A. 8GB
B. 16GB
C. 32GB
D. 64GB

Answer: B

Explanation: 
 The computer on which you are installing or upgrading Tableau Server must meet the minimum hardware requirements. If the Setup program determines that your
computer does not meet the following requirements, you will not be able to install Tableau Server. These minimum requirements are appropriate for a computer
that you use for prototyping and testing of Tableau Server. They apply to single-node installations and to each computer in a distributed installation.

Reference: https://help.tableau.com/current/server/en-us/server_hardware_min.htm

NEW QUESTION 32
Larger image
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What is this entire view referred to as in Tableau?

A. Data pane
B. Analytics Pane
C. Summary Pane
D. Distribution Pane

Answer: B

Explanation: 
 Distribution Pane
Explanation
This is the Analytics pane! Read more from the official documentation below:

Reference: https://help.tableau.com/current/pro/desktop/en- us/environ_workspace_analytics_pane.htm

NEW QUESTION 34
True or False: We get different colour pallete options if we drop a discrete field on "Color" in the marks card compared to if we drop a continous field on Color.

A. False
B. True

Answer: B

Explanation: 
 Yes! We get different color palettes. They are:
*From the official Tableau documentation*
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To change the color for a value
1) Click on an item on the left, under Select Data Item.
2) Click a new color in the palette on the right. In Tableau Desktop you can hover over a swatch to identify the color.
3) Repeat for as many values that you want to change.
4) In Tableau Desktop, click OK to exit the Edit Colors dialog box. In Tableau Server or Tableau Online, simply close the dialog box.
AND

Reference: https://help.tableau.com/current/pro/desktop/en us/viewparts_marks_markproperties_color.htm

NEW QUESTION 35
Which of the following is a valid way to create Sets in Tableau?

A. In the Data pane, right-click a dimension and select Create > Set.
B. In the Tableau Main Menu, Choose Worksheet and select Create > Set
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C. In the Tableau Main Menu, choose Dashboard and select Create > Set
D. In the Data pane, right-click a measure and select Create > Set.

Answer: A

Explanation: 
 There are two types of sets: dynamic sets and fixed sets. The members of a dynamic set change when the underlying data changes. Dynamic sets can only be
based on a single dimension.
To create a dynamic set:
1) In the Data pane, right-click a dimension and select Create > Set.
2) In the Create Set dialog box, configure your set. You can configure your set using the following tabs:
General: Use the General tab to select one or more values that will be considered when computing the set.
You can alternatively select the Use all option to always consider all members even when new members are added or removed.

None of the other options exist, and therefore are incorrect answers.
Reference: https://help.tableau.com/current/pro/desktop/en-us/sortgroup_sets_create.htm

NEW QUESTION 39
Which of the following represent a valid method to create a Bullet Graph with the LEAST number of fields possible?

A. using 2 measures
B. using 2 dimensions
C. using 2 dimensions and 3 measures
D. using 1 measure

Answer: A

Explanation: 
 A bullet graph is a variation of a bar graph developed to replace dashboard gauges and meters. A bullet graph is useful for comparing the performance of a
primary measure to one or more other measures. Below is a single bullet graph showing how actual
sales compared to estimated sales.
We can create a Bullet graph with just 2 measures! This method requires the LEAST number of fields possible to create this type of chart.
The best way to tackle such questions in the exam is to click the "SHOW ME" button on top right, and hover over the chart we want to create.
In our case, it is a Bullet graph.
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Therefore, we need 2 measures at least to create this chart, and 0 or more dimensions. Reference: https://help.tableau.com/current/pro/desktop/en-
us/qs_bullet_graphs.htm

NEW QUESTION 42
Which of the following are valid Layout Container types when using Dashboards in Tableau?

A. Vertical Container
B. Diagonal Container
C. Horizontal Container
D. Split Container

Answer: AC

Explanation: 
 Reference:
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https://help.tableau.com/current/pro/desktop/en-us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 43
What are three benefits of using an extract as compared to a live connection to a data source? Choose three.

A. A live connection to a data source can be slow due to network and user traffic, whereas a connection to an extract improves performance.
B. Extracts are stored in memory (RAM), resulting in faster query performance as compared with live data connections.
C. A live connection to a data source provides the best performance for data connections.
D. An extract reduces the amount of data stored on a client computer as compared to a live data connection.
E. Calculated fields perform better in workbooks connected to extracts than in workbooks with live connections to a data source.

Answer: ABE

Explanation: 
 There are three benefits of using an extract as compared to a live connection to a data source:
? A live connection to a data source can be slow due to network and user traffic,
whereas a connection to an extract improves performance. An extract is a snapshot of data that is stored locally on your computer or on Tableau Server. An
extract can reduce the load on the data source and speed up queries.
? Extracts are stored in memory (RAM), resulting in faster query performance as
compared with live data connections. When you use an extract, Tableau loads the data into memory and optimizes it for analysis. This allows Tableau to perform
calculations and aggregations faster than with live connections.
? Calculated fields perform better in workbooks connected to extracts than in
workbooks with live connections to a data source. Calculated fields are custom fields that you create using formulas or expressions. When you use an extract,

Guaranteed success with Our exam guides visit - https://www.certshared.com



Certshared now are offering 100% pass ensure TDS-C01 dumps!
https://www.certshared.com/exam/TDS-C01/ (314 Q&As)

Tableau can process calculated fields more efficiently than with live connections.

NEW QUESTION 46
How does Tableau know at which level to aggregate values?

A. Values are always aggregated at the level of granularity of the worksheet.
B. Tableau doesn't aggregate values, we do!
C. Values are always aggregated at the level of the Date Part
D. Aggregation is always done by using Tableau special formulas

Answer: A

Explanation: 
In Tableau, you can aggregate measures or dimensions, though it is more common to
aggregate measures. Whenever you add a measure to your view, an aggregation is applied to that measure by default. The type of aggregation applied varies
depending on the context of the view.
When you add a measure to the view, Tableau automatically aggregates its values. Sum, average, and median are common aggregations; for a complete list, see
List of Predefined Aggregations in Tableau.
The current aggregation appears as part of the measure's name in the view. For example, Sales becomes SUM(Sales). Every measure has a default aggregation
which is set by Tableau when you connect to a data source. You can view or change the default aggregation for a measure—see Set the Default Aggregation for a
Measure.
You can change the aggregation for a measure in the view from its context menu:

Reference: https://help.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm

NEW QUESTION 51
Data blending simulates a traditional _______ Join

A. Inner
B. Right
C. Full Outer
D. Left

Answer: D

Explanation: 
Data blending simulates a traditional left join. The main difference between the two is when the aggregation is performed. A join combines the data and then
aggregates. A blend aggregates and then combines the data.
From the official website:
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Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_connections.htm

NEW QUESTION 54
You have a visualization that uses multiple types of sorting. How can you clear all sorting of the visualization?

A. Right-click a sorted field, and then select Clear Sort.
B. From the Dashboard menu, select Clear.
C. From the Header label, select the sort icon.
D. From the Worksheet menu, select Clear, and then select Sorts.

Answer: D

Explanation: 
 To clear all sorting in a Tableau visualization, you would go to the Worksheet menu, select the "Clear" option, and then choose "Sorts." This action removes all
sorting that has been applied to the visualization, including any custom sorting or sorting based on multiple fields. This is a quick way to reset the view to its default
sorting state and is particularly useful when you have applied various sorting layers and wish to start fresh.

NEW QUESTION 57
What are two use cases for creating hierarchies from the Data pane? Choose two.

A. To organize related fields together
B. To create faster-performing queries
C. To concatenate all fields into a single field
D. To add drilldown functionality for fields

Answer: AD

Explanation: 
 Hierarchies in Tableau are used to define a drill-down path through your data. By creating a hierarchy, you can organize related fields together, which makes it
easier to navigate complex data models. This also allows users to explore data at different levels of detail, from the highest level of the hierarchy to the most
granular details, simply by clicking to expand and collapse levels of the hierarchy in the view.
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NEW QUESTION 62
When viewing quick table calculations, such as Percent Difference From, that use a value in the previous column, what will be the first data value in the
visualization?

A. Null
B. The current value
C. Zero(O)
D. Duplicated from the nearest column

Answer: A

Explanation: 
 According to the Tableau Desktop Specialist Exam Guide, when using quick table calculations, such as Percent Difference From, that use a value in the previous
column, the first data value in the visualization will be null, because there is no previous value to compare with.

NEW QUESTION 63
Which of the following are valid ways to show Mark Labels in the visualisation?

A. Click on the Show mark labels icon in the Toolbar
B. Drag the measure to the Text label in the Marks Card
C. Click on Data in the Menu bar and Choose Show Mark Labels
D. Click on Analysis in the Menu bar and choose Show Mark Labels

Answer: ABD

Explanation: 
The following showcase how you can show mark labels. Using the Sample Superstore dataset:
1) Let's create a Bar chart showing the sales for each sub-category:

2) Now you can show labels by:
* 2.1) Click on Show Mark Labels Icon in the Toolbar ( easiest )
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* 2.2) Drag Sales to the Text icon in the Marks Card:
* 2.3) Click on Analysis -> Show mark labels from the Tableau menu bar:

NEW QUESTION 68
What are two outcomes when you drag a continuous date value to the Rows shelf? Choose two,

A. The pill on the Rows shelf is green.
B. The pill on the Rows shelf is blue.
C. A quantitative axis is shown.
D. The date part Is displayed as labels.

Answer: AC

Explanation: 
 Dragging a continuous date value to the Rows shelf in Tableau results in a green pill on the Rows shelf, indicating a continuous field. It also results in a
quantitative axis being displayed on the visualization. Continuous fields are used to create axes on charts and can represent a range of values smoothly. This is
opposed to discrete date values, which would be represented by a blue pill and typically show headers or labels rather than a continuous axis.

NEW QUESTION 70
True or False: It is possible to change the Geographic Role of a dimension

A. True
B. False

Answer: A

Explanation: 
 A geographic role associates each value in a field with a latitude and longitude value. Assigning a geographic role based on the type of location (such as state
versus postcode) helps ensure that your data is plotted correctly on your map view. For example, you can assign the City geographic role to a field that contains a
list of city names.
To assign a geographic role to a field:
In the Data pane, click the data type icon next to the field, select Geographic Role, and then select the geographic role you want to assign to the field.
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When you assign a geographic role to a field, Tableau adds two fields to the Measures area of the Data pane: Latitude (generated) and Longitude (generated).
These fields contain latitude and longitude values and are assigned the Latitude and Longitude geographic roles. If you double-click each of these fields, Tableau
adds them to the Columns and Rows shelves and creates a map view using the Tableau background map.

Reference: https://help.tableau.com/current/pro/desktop/en-us/maps_geographicroles.htm

NEW QUESTION 72
Which of the following is a discrete date part?

A. 07Mar20l7
B. 20Sep2016:9:8:8:6546
C. 01/23/2021
D. February

Answer: D

Explanation: 
 February is a discrete date part, because it is a specific value that can be used to group or filter data by month. 07Mar2017, 20Sep2016:9:8:8:6546, and
01/23/2021 are continuous date values, because they represent points along a continuous timeline that can be used for analysis.

NEW QUESTION 77
Which of the following are interactive elements that can be added to a dashboard for users?

A. URL Action
B. Filter Action
C. Highlight Action
D. Edit Tooltip Action

Answer: ABC

Explanation: 
 We can perform filter, URL and highlight actions out of the above given choices on a dashboard. Please refer to the image below:

Reference: https://help.tableau.com/current/pro/desktop/en-us/actions_dashboards.htm

NEW QUESTION 79
Using the atheletes table:
i) Create a sheet with a crosstab showing the Average weight for each sport (Sheet 1)
ii) Create a sheet with a Map showing the Total number of gold medals per Country. Use size as a Mark. (Sheet 2)
Now, Create a Dashboard containing both these sheets, and Use Sheet 2 as a Filter for Sheet 1. What was the average weight for Badminton in Russia?
(Ignore any nulls / unknowns)
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A. 76.25
B. 65.67
C. 68.77
D. 4.87

Answer: A

Explanation: 
 Pretty common question on the Tableau Desktop Specialist exam.
1) First, lets create Sheet 1. For this, drag sport to the Row shelf, and Weight to the Text mark in the Marks shelf. Change its aggregation to Average:

2) Now, for sheet 2 - Drag nationality to the view, and gold to the size mark in the Marks shelf.
NOTE: Depending on your version of Tableau , you may need to assign a Geographical role to the nationality column first as follows:
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3) Now, let's create a dashboard, and use both these sheets in it:

4) Now, for the most Important step, use SHEET 2 AS A FILTER FOR SHEET 1 as follows:

Now simply click on Russia in Sheet 2, and Sheet 1 will automatically update as follows:
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NEW QUESTION 81
If you use a percent difference Quick Table Calculation, what value will be the first data value?

A. null
B. -1
C. 0000

Answer: A

Explanation: 
 When using a Percent difference, Tableau calculates what the percent change has occured as compared to the last data value. BUT, for the first data value, there
is no previous value to compare it to. Hence, it appears as NULL.

NEW QUESTION 86
Which of the following are true about Dashboards in Tableau?

A. Floating items can be layered over other objects
B. Tiled items don't overlap
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C. A bar chart can be used a floating item
D. None of these

Answer: ABC

Explanation: 
From the official Tableau documentation:

As we can see below, Bar charts can be used as a floating object.

Reference: https://help.tableau.com/current/pro/desktop/en- us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 87
_______ is a technique in Tableau which will identify marks with similar characteristics

A. Clustering
B. Grouping
C. Sets
D. Union

Answer: A
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Explanation: 
 Cluster analysis partitions marks in the view into clusters, where the marks within each cluster are more similar to one another than they are to marks in other
clusters.

Reference: https://help.tableau.com/current/pro/desktop/en-us/clustering.htm

NEW QUESTION 92
What is the following icon in the Data pane used to do? Larger image

A. View Data
B. Clean Data
C. Extract Data
D. Sort Data

Answer: A

Explanation: 
View Data allows you to inspect your data in a spreadsheet-like layout. You can view data either for the data source as a whole, or to see the underlying data for
an individual mark or a group of marks. In a worksheet, the rows that you see in the View Data window are always scoped to the current selection or the current
view.
The View Data window displays as much of the data as possible by default, up to 10,000 rows. Field names are shown as column headers and can be dragged
and dropped to change their display order. Click a column header to sort the values in that column.
From the official website:
Reference: https://help.tableau.com/current/pro/desktop/en-us/inspectdata_viewdata.htm

NEW QUESTION 94
If you are working with a huge dataset, which of the following are strong reasons to use a context filter?

A. Improve query performance
B. To make the context filter a dependent filter
C. To help clean the data
D. To include only the data of interest

Answer: AD

Explanation: 
By default, all filters that you set in Tableau are computed independently. That is, each filter accesses all rows in your data source without regard to other filters.
However, you can set one or more categorical filters as context filters for the view. You can think of a context filter as being an independent filter (Option stating -
To create a dependent filter eliminated
here). Any other filters that you set are defined as dependent filters because they process only the data that passes through the context filter.
You may create a context filter to:
1) Improve performance – If you set a lot of filters or have a large data source, the queries can be slow. You can set one or more context filters to improve
performance.
2) Create a dependent numerical or top N filter – You can set a context filter to include only the data of interest, and then set a numerical or a top N filter.
For example, suppose you’re in charge of breakfast products for a large grocery chain.
Your task is to find the top 10 breakfast products by profitability for all stores. If the data source is very large, you can set a context filter to include only breakfast
products. Then you can create a top 10 filter by profit as a dependent filter, which would process only the data that passes through the context filter.
Reference: https://help.tableau.com/current/pro/desktop/en-us/filtering_context.htm

NEW QUESTION 97
While borders and background colors let you visually highlight items on a dashboard, _____ lets you precisely space items.

A. padding
B. margining
C. tiling
D. spacing

Answer: A
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Explanation: 
 Padding lets you precisely space items on dashboard, while borders and background colors let you visually highlight them. Inner padding sets the spacing
between item contents and the perimeter of the border and background color; outer
padding provides additional spacing beyond the border and background color.
Reference: https://help.tableau.com/current/pro/desktop/en- us/dashboards_organize_floatingandtiled.htm

NEW QUESTION 102
You just added this field to the Columns shelf.

What will this create?

A. A vertical header
B. A horizontal axis
C. A vertical axis
D. A horizontal header

Answer: B

Explanation: 
We know that continuous fields will always create an axis, so options stating 'header' are automatically eliminated. For our question, see below:

Had the question asked us to place this pill on the Rows shelf instead, we would've gotten a different Answer

NEW QUESTION 104
True or False: It is not possible to blend axes for multiple measures into a single axis

A. False
B. True

Answer: A

Explanation: 
 We can very much blend multiple measures into a single axis. Such charts are called Combined-Axis / Blended-Axis charts. Follow along:
Measures can share a single axis so that all the marks are shown in a single pane. To blend multiple measures, drag one measure or axis and drop it onto an
existing axis.
Instead of adding rows and columns to the view, when you blend measures there is a single row or column and all of the values for each measure is shown along
one continuous axis. For example, the view below shows quarterly sales and profit on a shared axis.
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Note: If you drag a measure on to the canvas and only see a single ruler indicator instead of the double ruler indicator shown below, Tableau creates dual axes
instead of a blended axis. For more information about how to create dual axes, see Compare two measures using dual axes.
Reference: https://help.tableau.com/current/pro/desktop/en-us/multiple_measures.htm

NEW QUESTION 105
What should you use to apply bold text formatting to rows or columns independent of each other?

A. Text on the Marks card
B. The Field Format Font paneC The Rows tab or the Columns tab on the Format Font pane
C. The Sheets tab on the Format Font pane

Answer: B

Explanation: 
 To apply bold text formatting to rows or columns independently in Tableau, you should use the Rows tab or the Columns tab on the Format Font pane. This
approach provides control over the formatting of text within individual rows or columns. By selecting the appropriate tab (Rows or Columns), you can apply
formatting settings, including bold text, to only the selected rows or columns. This is a crucial feature for enhancing the readability and visual appeal of specific
parts of a Tableau worksheet, allowing for emphasis on particular data points or categories.

NEW QUESTION 106
Using the CoffeeChain table, create a scatter plot of Profit (x-axis) vs Sales (y-axis) broken down by State. Add a Linear trend line to the view. What is its R-
squared value?

A. 0.783262
B. 0.739284
C. 0.759329
D. 0.748472

Answer: A

Explanation: 
 Trend lines have become popular questions in recent Tableau examinations. Follow along:
1) First drag Sales to the Rows shelf and Profit to the Columns shelf:

You will only see a single mark since the view is aggregated.
2) Now, break down this view by state. Drag State into Detail on the Marks shelf ( or directly to the view):

3) Finally, move to the Analytics pane, and drag Trend line to the view. When you drag it, select the Linear option!:
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4) The following is our view. Hover over the trend line to see the R-squared value:

NEW QUESTION 111
You are creating a combined axis chart.
Where should you drag the second measure after dragging the first measure to the Rows shelf?

A. The Filter card
B. The vertical axis in the view
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C. The Marks card
D. The horizontal axis in the view

Answer: D

Explanation: 
 In Tableau, when creating a combined axis chart, after dragging the first measure to the Rows shelf, you should drag the second measure directly onto the
existing axis in the view. This will combine both measures on the same axis, allowing them to share a scale and an axis, which is the essence of a combined axis
chart.

NEW QUESTION 114
True or False: A sheet cannot be used within a story directly. Either sheets should be used within a dashboard, or a dashboard should be used within a story.

A. rue
B. False

Answer: B

Explanation: 
 It is possible in Tableau to use a sheet within a story directly.
Moreover, in Tableau, a story is a sequence of visualizations that work together to convey information. You can create stories to tell a data narrative, provide
context, demonstrate how decisions relate to outcomes, or to simply make a compelling case.
At the same time, a story is also a collection of sheets, arranged in a sequence. Each individual sheet in a story is called a story point.

Reference: https://help.tableau.com/current/pro/desktop/en-us/stories.htm

NEW QUESTION 117
Which of the following are valid use-cases for the 'Manage Metadata' functionality?

A. To clean and automatically fix the data issues in our data source
B. To see the field name in the original data source
C. To view all hidden fields
D. To see the table a field belongs to

Answer: BCD

Explanation: 
 Top of Form
To clean and automatically fix the data issues in our data source - This is the definition of Data Interpreter.
To rename the field in the original data source - We never modify the original data source when managing metadata. All changes are local to Tableau for our
convenience only.
All other options can be modified using the Manage Metadata property.
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NEW QUESTION 120
Which statement accurately describes creating a group by selecting headers in a view?

A. A new group updates the aliases from the selected headers.
B. The grouped dimension is added to Color.
C. The grouped dimension replaces the original dimension field on Rows or Columns.
D. A newly created group only exists in the current view.

Answer: C

Explanation: 
 When creating a group by selecting headers in a Tableau view, the newly created grouped dimension replaces the original dimension field on either the Rows or
Columns shelf. This grouping action aggregates the selected headers into a single group, and this new group dimension is automatically placed in the view,
replacing the original dimension. This functionality allows for more simplified and customized categorization within the data visualization, enhancing the ability to
analyze and interpret data according to specific groupings.

NEW QUESTION 124
Which of the following are valid ways to copy a worksheet visualisation as an image?

A. By simply clicking Control + V on the keyboard
B. By clicking on Worksheet in the Tableau Main Menu above, and choosing Copy->Image
C. Using the Marks shelf and choosing Copy->Image
D. By right clicking on the worksheet visualisation and selecting Copy->Image

Answer: BD

Explanation: 
 The following are 2 correct ways to copy the worksheet visualisation as an image:

AND
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Reference: https://help.tableau.com/current/pro/desktop/en-us/save_export_image.htm

NEW QUESTION 127
You create a dashboard that tracks your teams progress on various projects. On the dashboard, you want to display your company's web page. Which dashboard
element should you use?

A. A navigation object
B. A URL action
C. An extension
D. A web page object

Answer: D

Explanation: 
 To display your company's web page on a Tableau dashboard, you should use a web page object. The web page object allows you to embed a web page within
your Tableau dashboard, providing direct access to external web content.
? Open your Dashboard: Start by opening the dashboard where you want to add the
web page.
? Add Web Page Object: In the Objects section of the dashboard pane, select the "Web Page" object and drag it onto your dashboard.
? Configure URL: After placing the web page object, a dialog box will prompt you to enter the URL of the web page you want to display. Enter your company's web
page URL here.
? Resize and Position: Adjust the size and position of the web page object to fit your dashboard design.
References:
? Tableau's official documentation on dashboard objects: Dashboard Objects

NEW QUESTION 129
Which of the following are true about dimensions?

A. They contain contain numeric, quantitative values
B. They contain qualitative values (such as names, dates, or geographical data)
C. They affect the level of detail in the view
D. Dates are mostly placed in dimensions by default for relational data sources

Answer: BCD

Explanation: 
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Measures contain numeric quantitative values hence that option is incorrect.
Reference 1: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm
Reference 2: https://help.tableau.com/current/pro/desktop/en-us/dates.htm

NEW QUESTION 134
When using a data source that has relationships, how can you add a join between two or more tables?

A. From the Tables pane, double-click a table.
B. From the Tables pane, drag a table directly on top of an existing logical table.
C. From the Connections pane, select Add.
D. Double-click a logical table in the canvas.

Answer: C

Explanation: 
 When using a data source that has relationships, you can add a join between two or more tables by dragging a table directly on top of an existing logical table
from the Tables pane. This will create a logical table that contains the joined tables. You can then edit the join type, join clauses, and join calculation as needed2
The other options are not valid ways to add a join between tables when using relationships. From the Tables pane, double-clicking a table will add it to the data
source as a separate logical table, not joined with any other table. From the Connections pane, selecting Add will allow you to add
another connection to the data source, not join tables within the same connection. Double- clicking a logical table in the canvas will open the Data Source page,
where you can view and edit the fields in the logical table, not join it with another table2

NEW QUESTION 139
What are three options to change the scope of a reference line? Choose three.

A. Per Pane
B. Fill Above
C. Entire Table
D. Maximum
E. Per Cell
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Answer: ACE

Explanation: 
 You can change the scope of a reference line by choosing one of the following options: Per Pane, Entire Table, or Per Cell. The scope determines how many
reference lines are added to the view and how they are calculated. Per Pane adds one reference line for each pane in the view. Entire Table adds one reference
line for the entire table in the view. Per Cell adds one reference line for each cell in the view

NEW QUESTION 142
Is it possible to add both a Dashboard and a Worksheet at the same time to a Story Point in Tableau?

A. Yes
B. No

Answer: B

Explanation: 
This is a tricky question. We are talking about story POINTS, and not entire stories in the question.
To create a story, lets say I have a blank story with 1 dashboard and 1 worksheet. I can simply drag the dashboard into the view to create a new story point.

Now, if I try to adjust the worksheet beside it in this same view, I cannot. See below:

The only option available is to replace the existing view. Therefore, the answer is NO since
they both cannot be added.
Read more about stories in Tableau: https://help.tableau.com/current/pro/desktop/en- us/story_create.htm

NEW QUESTION 147
_____ is a snapshot of the data that Tableau stores locally. Good for very large datasets of which we only need few fields.

A. Tableau Packaged Workbook (.twbx)
B. Tableau Workbook (.twb)
C. Tableau Data Extract (.tde)
D. Tableau Data Source (.tds)

Answer: C

Explanation: 
 Tableau Data Extract (TDE) is a snapshot of the data that Tableau stores locally. Good for very large datasets of which we only need few fields. Performance is
optimised because it queries its own database engine instead of the local data source.
When you create an extract of your data, you can reduce the total amount of data by using filters and configuring other limits. After you create an extract, you can
refresh it with data from the original data. When refreshing the data, you have the option to either do a full refresh, which replaces all of the contents in the extract,
or you can do an incremental refresh, which only adds rows that are new since the previous refresh.
Extracts are advantageous for several reasons:
1) Supports large data sets: You can create extracts that contain billions of rows of data.
2) Fast to create: If you're working with large data sets, creating and working with extracts can be faster than working with the original data.
3) Help improve performance: When you interact with views that use extract data sources, you generally experience better performance than when interacting with
views based on connections to the original data.
4) Support additional functionality: Extracts allow you to take advantage of Tableau functionality that's not available or supported by the original data, such as the
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ability to compute Count Distinct.
5) Provide offline access to your data: Extracts allow you to save and work with the data locally when the original data is not available. For example, when you are
traveling.

NEW QUESTION 149
You have a workbook that contains one data source and you need to combine data from another database. What should you do first?

A. Create an extract.
B. Add a new connection.
C. Add a new data source from the data source canvas.
D. Edit the existing connection.

Answer: B

Explanation: 
 To combine data from another database with an existing data source in Tableau, the first step is to add a new connection. This will allow you to access the
additional database and either blend or join the data from the two sources depending on your analysis needs.

NEW QUESTION 152
Which of the following are valid ways to Bold the Tooltip content in Tableau?

A. Click on Analysis, Tooltip options, and select bold.
B. Click on Tooltip in the Marks card, and select bold.
C. Click on Worksheet in the Menu bar, followed by Tooltip and select the bold option
D. Right click, click format and then under the default worksheet formatting, choose Tooltip and make it bold.

Answer: BCD

Explanation: 
Lot of students have been seeing this question in the exam lately, and wanted me to include this question so here it is. Follow along -
1) Click on Worksheet in the Menu bar, followed by Tooltip and select the bold option
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2) Click on Tooltip in the Marks card, and select bold.

3) Right click, click format and then under the default worksheet formatting, choose Tooltip and make it bold.
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There exists no option to Bold the tooltip contents by clicking Analysis. Hence, it is an incorrect choice.

NEW QUESTION 154
Which two elements can have their values changed by using a dashboard action? Choose two.

A. Bins
B. Groups
C. Sets
D. Parameters

Answer: CD

Explanation: 
 In Tableau, the two elements that can have their values changed by using a dashboard action are Sets and Parameters. Dashboard actions can be configured to
modify the values within a set or a parameter, allowing for interactive and dynamic changes in the visualization based on user interactions. For example, selecting
a specific data point in a dashboard can trigger an action that updates a set or changes the value of a parameter, which in turn can alter the displayed data or the
appearance of visualizations within the dashboard.

NEW QUESTION 159
Which two functionalities can you provide to consumers by adding a parameter to a visualization? Choose two.

A. Change fields in the visualization.
B. Download the underlying data as a CSV file.
C. Change the results of calculations in the visualization.
D. Create a new field in the data source.

Guaranteed success with Our exam guides visit - https://www.certshared.com



Certshared now are offering 100% pass ensure TDS-C01 dumps!
https://www.certshared.com/exam/TDS-C01/ (314 Q&As)

Answer: AC

Explanation: 
 In Tableau, parameters are dynamic values that can replace a constant in calculations, filters, and reference lines. If you have a parameter controlling a
calculation, changing the parameter value can change the results of that calculation, thus impacting the visualization. Parameters can also be used to switch
between different fields in the visualization; for example, allowing users to choose which measure or dimension to display.

NEW QUESTION 161
According to Tableau's 'Order of Operations', which of the following filters is applied FIRST?

A. Dimension Filter
B. Measure Filter
C. Context Filter
D. Extract Filter

Answer: D

Explanation: 
According to Tableau's order of operations, the Extract filter is right at the top of the hierarchy. The data filtered in the Extract is then passed on to what we see in
the Data Pane. See below:

Reference: https://help.tableau.com/current/pro/desktop/en-us/order_of_operations.htm

NEW QUESTION 162
For a ______ sort, no matter how the data changes, the values will always stay in the sort order we kept stuff in.

A. Random
B. Manual
C. Topological
D. Hierarchical

Answer: B

Explanation: 
 For a manual sort, no matter how the data changes, the values will always stay in the sort order you kept stuff in.
From the official website:
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Reference: https://help.tableau.com/current/reader/desktop/en-us/reader_sort.htm

NEW QUESTION 165
The Shape option is available for which two views? Choose two.

A. Side-by-side circles
B. Scatter plots
C. Heat maps
D. Packed bubbles

Answer: BD

Explanation: 
 The Shape option is available for scatter plots and packed bubbles views. The Shape option allows you to change the shape of marks in the view by selecting
from a predefined set of shapes or adding custom shapes. You can access the Shape option by placing any field on Shape on the Marks card4 Scatter plots are
views that show the relationship between two numerical variables by plotting them as coordinates on a Cartesian plane. You can create a scatter plot by placing at
least one measure on Columns and at least one measure on Rows on the Marks card. You can then use Shape to assign different shapes to different categories
or segments in your data5 Packed bubbles are views that show hierarchical data as a set of nested circles. Each circle represents a dimension member and its
size is proportional to a measure value. You can create a packed bubble chart by placing one or more dimensions on Detail and one measure on Size on the
Marks card. You can then use Shape to change the shape of circles to other shapes such as squares or stars6 The other options are not valid views for using the
Shape option. Side-by-side circles are views that show proportions of a whole by using circles with different angles and sizes arranged horizontally or vertically.
You can create a side-by-side circle chart by placing one dimension on Columns or Rows and one measure on Angle and Size on the Marks card. You cannot use
Shape to change the shape of circles in this view7 Heat maps are views that show the distribution of two or more measures by using a color gradient and size. You
can create a heat map by placing one or more dimensions on Columns and Rows and two measures on Color and Size on the Marks card. You cannot use Shape
to change the shape of marks in this view8

NEW QUESTION 170
Which three elements are included in a packaged workbook (.twbx)? Choose three.

A. A PDF copy of the workbook
B. Background images
C. Tableau Datasource Customization (TDC) files
D. Extract files
E. Custom shapes

Answer: BDE

Explanation: 
 According to the Tableau Desktop Specialist Exam Guide, a packaged workbook (.twbx) includes background images, extract files, and custom shapes. A PDF
copy of the workbook and Tableau Datasource Customization (TDC) files are not included in a packaged workbook.

NEW QUESTION 174
When using Animations in a Tableau, which of the following is the default duration for animations?

A. 0.4s
B. 0.3s
C. 0.5s
D. 0.2s

Answer: B

Explanation: 
The LATEST Tableau Desktop Sepcialist exam blueprint now requires you to know some basics about animations as well!
NOTE: Animations are DISABLED by default and must be manually enabled.
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You can also reset all settings to default by clickin on 'Reset All'

Reference: https://help.tableau.com/current/pro/desktop/en-us/formatting_animations.htm

NEW QUESTION 176
Using the dataset, create a bar chart showing the average Quantity broken down by Region, and filtered by Country to only show Japan. What was the average
Quantity in the State of Tokyo?

A. 3.000
B. 3.840
C. 3.704
D. 3.500

Answer: C

Explanation: 
 Since we need to focus on 1 country -> Japan, let's filter on it first as follows:
1) Drag Country to the filter shelf, and choose only Japan. Click OK.
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2) Read the Question Carefully, we need to break down the visualisation by Region, then by Country, and then by State. So let's do that:
Drag Region to the column shelf, followed by Country. Drill down into Country to include states as well.
Then drag Quantity to the Row Shelf, and change the Aggregation to AVERAGE. The following is our visualisation:

Now that you think of it, EVEN IF YOU REMOVE THE REGION, THE ANSWER REMAINS
THE SAME. Such elements will be present in the actual exam too, just to make the question sound a little difficult, but actually it is pretty straightforward :)

NEW QUESTION 178
By default, measures placed in a view are aggregated. The type of aggregation applied _______

A. 
is always sum

B. depends on the context of the view
C. is always COUNT
D. is always AVERAGE

Answer: B

Explanation: 
 By default, measures placed in a view are aggregated. Mostly you'll notice that the aggregation is SUM, but not ALWAYS.
The type of aggregation applied varies depending on the context of the view. Reference: https://help.tableau.com/current/pro/desktop/en-
us/calculations_aggregation.htm

NEW QUESTION 182
Which Sub-Category had the least Profit in the Office Supplies category?

A. Fasteners
B. Labels
C. Envelopes
D. Binders

Answer: A
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Explanation: 
To reach the correct answer, follow the steps below:

1) Drag Category, and sub-category to the row shelf. Drag Profit to the Column shelf
2) Click the Sort-ascending icon as shown above, to sort the profits from least to greatest as shown:
Click the 'Show mark labels icon'

As we can see, Fasteners has the least Profit in the Office Supplies Category, and hence is our correct answer!

NEW QUESTION 186
What is created by a calculated field that has a formula of SUM(Sales)/SUM(Profit)?

A. A parameter
B. A measure
C. A dimension
D. A set

Answer: B

Explanation: 
 a calculated field that has a formula of SUM(Sales)/SUM(Profit) is a measure, because it returns a numeric value that can be aggregated and used for analysis. A
parameter is a user-defined variable that can be used in calculations or filters. A dimension is a categorical field that can be used to group or slice data. A set is a
subset of data based on some condition.

NEW QUESTION 187
Using the Time-series table, create a cross tab showing the Sales for each Item Number- ID, broken down by Assortments, then add Grand totals to the view.
Which Item Number ID made the maximum sales across all assortments?

A. 584
B. 901
C. Correct)
D. 205
E. 660

Answer: B

Explanation: 
 Explanation Follow along the steps below:
? Drag Assortment and Year ID to the column shelf, and Item Number ID to the row shelf. Next, drag Sales to the Text label to create a cross-tab as below:

NEW QUESTION 188
What are two requirements to combine two tables by using a union? Choose two.

A. Related fields must have matching data types.
B. Related fields must have different names.
C. The tables must come from different connections.
D. The tables must have the same number of fields.

Answer: AD

Explanation: 
 To perform a union in Tableau, the tables must have a related field with matching data types, and they must have the same number of fields. This allows the
tables to be appended vertically in the data source. Different names or tables from different connections do not affect the ability to union the tables.
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NEW QUESTION 190
Dragging a ______ to colour creates distinct colours for each item whereas dragging a _____ to colour creates a gradient

A. Discrete value, Continuous Value
B. Geographic Value, Discrete Value
C. Continuous Value, Discrete Value
D. Longitude, Latitude

Answer: A

Explanation: 
Remember that dragging a discrete value to colour creates distinct colours for each item whereas dragging a continuous value to colour creates a gradient. ( Same
for Map )
From the official documentation:

Reference: https://help.tableau.com/current/pro/desktop/en-us/viewparts_marks_markproperties_color.htm

NEW QUESTION 191
Given a map, which of the following fields can be placed on Size,Shape,Detail,Color

A. Region, Country, Profit, State
B. Sales, State, Country, Profit
C. Profit, State, Number of Records, Sales
D. Longitude, Country, State, Sales

Answer: B

Explanation: 
 Since Sales is a measure, it can easily be depicted via size.
To drill down and change the level of detail, Country is the correct choice since it
will contain STATE. We can then depict the various states by different shapes such as circle, square etc.
Finally, the Profit can be depicted via a color! Eg - Red for poor and green for excellent profits!
Reference: https://www.tableau.com/learn/tutorials/on-demand/aggregation-granularity-and-ratio-calculations

NEW QUESTION 192
Which of the following are valid ways to make the font more readable in Tableau?

A. Decrease the font size
B. Don't use backgrounds
C. use a clear and readable font
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D. Make the Font color sharper / darker than the background
E. Increase the font size

Answer: CDE

Explanation: 
This is one of the most common questions on the Tableau Desktop Specialist Exam. Wrong options -
1) Don't use backgrounds - This is not a solution. What if we want to use backgrounds? We can't just stop using backgrounds to solve this problem.
2) Decrease the font size - Do you think using a smaller font will make the text more readable? No right? Hence, this is wrong too.
All other options are ways recommended to make your text more readable!

NEW QUESTION 196
_____ contains the visualisations, info needed to build the visualisations, and a copy of the data source.

A. Tableau Data Extract (.tde)
B. Tableau Packaged Workbook (.twbx)
C. Tableau Bookmark (.tbm)
D. Tableau Workbook (.twb)

Answer: B

Explanation: 
 TWBX is all in one. It contains viz, info needed to build the viz, and a copy of the data source. It doesn’t contain extracts of the data but can contain both live and
data extracts. Best if want to eliminate the barrier of data access.
Create a .twbx with file-based data sources
1) Select File > Save As.
2) Specify a file name for the packaged workbook in the Save As dialog box.

3) Select Tableau Packaged Workbooks on the Save as type drop-down list.
4) Click Save.
5) The default location is the Workbooks folder of the Tableau repository. However, you can save packaged workbooks to any directory you choose.
The following files are included in packaged workbooks:
--> Background images
--> Custom geocoding
--> Custom shapes
--> Local cube files
--> Microsoft Access files
--> Microsoft Excel files
--> Tableau extract files (.hyper or .tde)
--> Text files (.csv, .txt, etc.)
Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 198
A dual axis chart is useful for comparing two measures that _____.

A. have different scales
B. have little in common
C. are Table Calculations
D. are aggregated Dimensions

Answer: A

Explanation: 
 A dual axis chart is useful for comparing two measures that have different scales. A dual axis chart is a type of visualization that shows two measures using two
independent axes layered on top of one another. A dual axis chart allows you to compare and contrast two measures that have different ranges or units of
measurement, such as sales and profit margin, temperature and precipitation, or population and GDP per capita. A dual axis chart can also show different mark
types for each measure, such as bars and lines, circles and areas, or shapes and texts. The other options are not valid reasons for using a dual axis chart for
comparing two measures. Have little in common is not correct, because a dual axis chart is meant to show some kind of relationship or correlation between two
measures, not just contrast them. Are Table Calculations is not correct, because a dual axis chart can be used with any type of measure, whether it is an
aggregation, a calculation, or an expression. Are aggregated Dimensions is not correct, because a dual axis chart cannot be used with dimensions, only with
measures. Dimensions are fields that contain qualitative values that are used to categorize or segment data, not compare them.
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NEW QUESTION 199
What do the colours Blue and Green represent in Tableau?

A. Discrete and Continuous
B. Measures and Dimensions
C. Continuous and Discrete
D. Dimensions and Measures

Answer: A

Explanation: 
Important question! If you selected Dimension and Measure, don't worry! It is a very common mistake. But we're here to learn aren't we?
When you connect to a new data source, Tableau assigns each field in the data source as dimension or measure in the Data pane, depending on the type of data
the field contains. You use these fields to build views of your data.
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Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 201
Which of the following are valid ways to italicize Tooltip content in Tableau?

A. Click on Format in the Menu bar, choose Font, and then edit the Tooltip options to italicize the font
B. Click on Tooltip in the Marks card, select the text, and then use the Italics option
C. Click on Worksheet in the Menu bar, select Tooltip, and then use the italics option
D. Click on Dashboard in the Menu bar, select Tooltip, and then use the italics option

Answer: ABC

Explanation: 
The only incorrect option is - Click on Dashboard in the Menu bar, select Tooltip, and then use the italics option.
This option doesn't exist. See below:

The rest of the options do exist, and therefore are correct:
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NEW QUESTION 203
How can you add color to marks in the view in Tableau?

A. Click on Data in the main menu above, and click on choose color.
B. From the Data pane, drag a field to Color on the Marks card.
C. In the column/row shelf, right click the field and click on edit in shelf to select the color.
D. From the Analytics pane, drag a model to Color on the Marks card.

Answer: B

Explanation: 
To assign a color to marks in the view, do the following: From the Data pane, drag a field to Color on the Marks card.
Tableau applies different colors to marks based on the field’s values and members. For example, if you drop a discrete field (a blue field), such as Category, on
Color, the marks in the view are broken out by category, and each category is assigned a color.
If you drop a continuous field, such as SUM(sales), on Color, each mark in the view is colored based on its sales value.

NEW QUESTION 206
You want to provide additional information when hovering over a field in the Data pane as shown in the following exhibit.
What should you configure for the field?

A. An alias
B. A header label
C. A hierarchy
D. A default comment

Answer: D

Explanation: 
 To provide additional information when hovering over a field in the Data
pane, as shown in the exhibit, you need to configure a default comment for the field. This comment can be set by right-clicking on the field in the Data pane and
selecting "Default Properties" and then "Comment." The text entered as a comment here will then be displayed as a tooltip when hovering over the field in the Data
pane.

NEW QUESTION 210
True or False: It is possible to add a field to more than one hierarchy

A. True
B. False

Answer: A

Explanation: 
 Yes! It is possible to duplicate a field and add it to more than one hierarchy. Right click and choose duplicate.
Reference: https://www.tableau.com/about/blog/2016/8/take-note-these-10-handy-tableau- shortcuts-57561

NEW QUESTION 212
In which of the following scenarios would having a live connection be more beneficial than using an extract?

A. Analyzing real time stock prices
B. Analyzing real time data from production systems
C. Analyzing historical housing prices
D. Analyzing and tracking real time flight updates
E. Analyzing a subset of a dataset having 1 billion rows

Answer: ABD

Explanation: 
 Extracts would be more beneficial for analyzing historical prices where we won't be making use of any real time data being streamed. Same is the case for
enormous datasets having billions of rows (extracts will be more efficient in analyzing subsets of such large data).
As for live stock prices, flight updates, real time updates from production or mission critical systems - having a live connection is the most logical choice, since we
need access to the most fresh and recent data possible at all times!

NEW QUESTION 216
Is it possible to make a Measure discrete?

A. No
B. Yes

Answer: B

Explanation: 
Of course! Follow along:
Right click on any measure, and choose Discrete as shown:
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Once you do this, the green pill becomes blue in colour, indicating that it is now Discrete!

Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 221
Which of the following is a benefit of using a Tableau Data Source (.tds)?

A. To hold one or more worksheets, plus zero or more dashboards and stories.
B. To not contain the actual data but rather the information necessary to connect to the actual data as well as any modifications you've made on top of the actual
data such as changing default properties, creating calculated fields etc
C. To create a single zip file that contains a workbook along with any supporting local file data and background image
D. This is great for sharing your work with others who don’t have access to the original data.
E. To create a local copy of a subset or entire data set that you can use to share data with others, when you need to work offline, and improve performance.

Answer: B

Explanation: 
The following are the official definitions from the Tableau documentation for the various file types:
1) .tds (Tableau Data Source) - To not contain the actual data but rather the information necessary to connect to the actual data as well as any modifications
you've made on top of the actual data such as changing default properties, creating calculated fields etc. (CORRECT ANSWER)
2) .twbx ( Tableau packaged workbook) - To create a single zip file that contains a workbook along with any supporting local file data and background images. This
is great for sharing your work with others who don’t have access to the original data.
3) Extract (.hyper or .tde) – To create a local copy of a subset or entire data set that you can use to share data with others, when you need to work offline, and
improve performance.
3) (.twb) Workbooks – To hold one or more worksheets, plus zero or more dashboards and stories.
Reference: https://help.tableau.com/current/pro/desktop/en-us/environ_filesandfolders.htm

NEW QUESTION 226
You create a crosstab that shows a list of 100 hotel chains alongside their average nightly cost. You also create two groups showing, respectively, the top 10 and
bottom 10 hotel chains by cost, with subtotals.
What should you do to improve the crosstab and compare the two groups to all the
remaining hotel chains?

A. Include an Other group.
B. Include the Summary card.
C. Color encode the hotel chain names.
D. Create a new view.

Answer: A

Explanation: 
 According to the Tableau Help, one of the ways to improve a crosstab is to “Include an Other group”. The help also states that “If you have a large number of
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members in a dimension, you can create groups to combine low-frequency members into an Other group. This can help you focus on the most relevant data and
reduce clutter in your view” (page 2).

NEW QUESTION 230
_______ is useful when you need to change how the data source is configured on a sheet-by-sheet basis, and when you want to combine databases that don’t
allow relationships or joins

A. Union
B. Data Joining
C. Data segregation
D. Data Blending

Answer: D

Explanation: 
Data blending is performed on a sheet-by-sheet basis and is established when a field from a second data source is used in the view. To create a blend in a
workbook already connected to at least two data sources, bring a field from one data source to the sheet—it becomes the primary data source.
Switch to the other data source and use a field on the same sheet—it becomes a secondary data source. An orange linking icon will appear in the data pane,
indicating which field(s) are being used to blend the data sources.
According to the official Tableau Documentation:

To read more about Data Blending, click on THIS link.

NEW QUESTION 231
Using the Time Series table, create a cross-tab showing sales for each Assortment broken down by Year and Quarter. In Q4 of October 2017, what was the
Average sales amount for the Hardware assortment?

A. 111,060
B. 1,461
C. 112,256
D. 1,222

Answer: C

Explanation: 
 If you chose 111,060 you were SO close to the correct answer but made a small mistake - you didn't change the aggregation to AVERAGE! This is one of the
common mistakes many test takers make, so keep this in mind.
To reach the correct answer, follow the steps below:
1) Draw Assortment to the Column shelf, and drag Year to the Rows Shelf. Then Drill down further on Year to accomodate Quarters and Months as well!
Although this seems enough, DON'T FORGET to change the aggregation like in the next step, which will completely change the values!
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? The correct answer as you can see is 1,461 - Sales for Harware Assortment in 2017 Q4, October

NEW QUESTION 234
What two methods can you use to change the font of a worksheet title? Choose two.

A. Double-click the title in a particular view and use the dialog box.
B. Right-click the title in a view, and then select Format Title.
C. Select Format on the menu, and then select Font.
D. Select Format on the menu, and then select Title and Caption.

Answer: AD

Explanation: 
 In Tableau, you can change the font of a worksheet title by double-clicking directly on the title in the view, which opens a dialog box where you can format the text,
including changing the font. Another method is to use the Format menu; from there, you select "Title and Caption," which opens the Format Title pane on the left
side of the screen, where you can change the font and other formatting options for the worksheet title.

NEW QUESTION 237
We can use ______ as a static tool to open and interact with packaged workbooks with extracted data sources that have been created in Tableau Desktop.

A. Tableau Reader
B. Tableau Online
C. Tableau Server
D. Tableau Desktop

Answer: A

Explanation: 
 The word 'static tool' gives it away.

Guaranteed success with Our exam guides visit - https://www.certshared.com



Certshared now are offering 100% pass ensure TDS-C01 dumps!
https://www.certshared.com/exam/TDS-C01/ (314 Q&As)

According to the official website :

Reference: https://help.tableau.com/current/reader/desktop/en-us/reader_welcome.htm

NEW QUESTION 240
Which of the following can help us focus on specific data without removing data in the visualization?

A. Highlighters
B. Sets
C. Clusters
D. Filters

Answer: A

Explanation: 
 From the official documentation:
When you have a view with a large amount of data you might want to explore your data interactively and highlight a specific mark or group of marks while still
maintaining the context of where those marks show in your view.
To do this you can turn on the Highlighter for one or more discrete fields that are included in your view and that affect the level of detail
Example - Here we just want to focus on Public Affairs college dimension, but don't want to filter out or remove the rest of the data:

Note that filtering is not the correct option since that would REMOVE the data that doesn't match the filtering criteria.
Reference : https://help.tableau.com/current/pro/desktop/en- us/actions_highlight_highlighter.htm

NEW QUESTION 242
How can you format an axis as Bold in Tableau?

A. By choosing the axis and selecting Command/Control + B on your keyboard
B. By right clicking on the axis, choosing Edit Axis, and then setting its font to bold.
C. By right clicking on the axis, choosing format, and then setting its font to bold.
D. By clicking on Format on the main menu bar, choosing field labels, and setting it to bold.

Answer: C

Explanation: 
To make an axis bold, simply right click it, select format, and then click on Font to choose Bold:
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None of the other options are valid ways to make the axis bold.

Read more about editing axis: https://help.tableau.com/current/pro/desktop/en- us/formatting_editaxes.htm

NEW QUESTION 244
You want to save a view as an image that you can paste into a Microsoft Word document. Which two statements accurately describe exporting a view as an
image? Choose two.

A. Default exports include everything in the view, including Tableau fonts.
B. The default export format is TIFF.
C. The default export format is PNG.
D. The exported image is a vector-based file that embeds the Tableau fonts.

Answer: AD

Explanation: 
 When exporting a view as an image in Tableau, the default export includes everything that is currently displayed in the view, with Tableau applying its own styling,
including fonts. The default format for an exported image is PNG, which is a raster-based file format that captures all visual elements as pixels. PNG is widely used
for its lossless compression and is suitable for detailed images like those produced by Tableau. Unlike vector-based images, PNGs do not embed fonts, and the
image quality remains consistent when the image is viewed on different platforms, which makes it ideal for inserting into documents like Microsoft Word.

NEW QUESTION 248
______ is a method for appending values (rows) to tables. You can use this method if both tables have the same columns. The result is a virtual table that has the
same columns but extends vertically by adding rows of data.
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A. Joining
B. Blending
C. Combining
D. Unioning

Answer: D

Explanation: 
Unioning is the correct answer! From the official documentation:

For example, suppose you have the following customer purchase information stored in three tables, separated by month. The table names are "May2016" ,
"June2016" and "July2016."

Reference: https://help.tableau.com/current/pro/desktop/en-us/union.htm

NEW QUESTION 253
Which of the following 2 columns CANNOT be deleted in Tableau?

A. Measure Names
B. Number of Records
C. Measure Values
D. Calculated Fields

Answer: AC

Explanation: 
 Measure names and values CANNOT be deleted in Tableau like other columns can. These are auto-generated.
Calculated Fields, and Number of records can both be deleted.

NEW QUESTION 257
Which of the following are stored in a .tds file? Choose 3.

A. Data Connection information
B. Visualizations
C. Calculated Fields
D. Data Extracts
E. Metadata edits

Answer: ACE

Explanation: 
 If you’ve created a data connection that you might want to use with other workbooks or share with colleagues, you can export (save) the data source to a file. You
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might want to do this also if you’ve added joined tables, default properties, or custom fields—such as groups, sets, calculated fields, and binned fields—to the Data
pane.

Visualisations and Data extracts are NOT saved in a .tds file!
Reference: https://help.tableau.com/current/pro/desktop/en-us/export_connection.htm

NEW QUESTION 258
True or False: Trend lines can only be used with numeric or date fields

A. True
B. False

Answer: A

Explanation: 
 You can show trend lines in a visualization to highlight trends in your data.
To add trend lines to a view, both axes must contain a field that can be interpreted as a number. For example, you cannot add a trend line to a view that has the
Product Category dimension, which contains strings, on the Columns shelf and the Profit measure on the Rows shelf.
However, you can add a trend line to a view of sales over time because both sales and time can be interpreted as numeric values.
Reference: https://help.tableau.com/current/pro/desktop/en-us/trendlines_add.htm

NEW QUESTION 260
Using the Geo Data Table, create a Map showing Sales made per State. For the State of New York (NY), what was the amount in Sales ($) made for Phone
Assortments with White color?

A. $16,581
B. (Correct)
C. $147,950
D. $48,115
E. $33,768

Answer: A

Explanation: 
 Phew! Tricky one! You needed to use filters in this one. Follow along:
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2) Next, as the question mentions, we need to focus on the Assortment PHONE, the color WHITE, and the state of NEW YORK. -> so we use filters for this!
i) First drag Assortment to Filters, and select only Phones :

ii) Next, drag Color to Filters and Choose only White:

iii) Next, drag State ID to Filters, and choose New York (NY):

And Voila! We have our answer as follows:

iv) Last, drag Sales to Label:

NEW QUESTION 262
Which of the following chart type makes use of 'binned' data?
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A. Gantt Chart
B. Bullet chart
C. Histogram
D. Treemaps

Answer: C

Explanation: 
 A histogram is a chart that displays the shape of a distribution. A histogram looks like a bar chart but groups values for a continuous measure into ranges, or bins.

Reference: https://help.tableau.com/current/pro/desktop/en- us/buildexamples_histogram.htm

NEW QUESTION 263
Which of the following are FALSE about Joins?

A. Joins can be defined at the time of query dynamically
B. May drop unmatched measure values
C. They are displayed with Venn diagram icons between physical tables
D. Joined tables are never merged into a single table.
E. They are a more dynamic way than relationships to combine data

Answer: ADE

Explanation: 
According to the official documentation:
Joins are a more static way to combine data. Joins must be defined between physical tables up front, before analysis, and can’t be changed without impacting all
sheets using that data source. Joined tables are always merged into a single table. As a result,
sometimes joined data is missing unmatched values, or duplicates aggregated values.
Joins -
1) Are displayed with Venn diagram icons between physical tables
2) Require you to select join types and join clauses
3) Joined physical tables are merged into a single logical table with a fixed combination of data
4) May drop unmatched measure values
5) May duplicate aggregate values when fields are at different levels of detail
6) Support scenarios that require a single table of data, such as extract filters and aggregation
Reference: https://help.tableau.com/current/online/en-
us/datasource_relationships_learnmorepage.htm

NEW QUESTION 266
Larger image
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What is this view referred to as in Tableau?

A. Analytics Pane
B. Window Pane
C. Data Pane
D. Dimensions & Measures

Answer: C

Explanation: 
 Tableau displays data source connections and data fields for the workbook in the Data pane on the left side of the workspace.
The Data pane includes:
Dimension fields – Fields that contain qualitative values (such as names, dates, or geographical data). You can use dimensions to categorize, segment, and reveal
the details in your data. Dimensions affect the level of detail in the view. Examples of dimensions include dates, customer names, and customer segments.
Measure fields – Fields that contain numeric, quantitative values can be measured. You can apply calculations to them and aggregate them. When you drag a
measure into the view, Tableau applies an aggregation to that measure (by default). Examples of measures: sales, profit, number of employees, temperature,
frequency.
For more information on what dimensions and measures are, see Dimensions and Measures, Blue and Green.
Calculated fields – If your underlying data doesn't include all of the fields you need to answer your questions, you can create new fields in Tableau using
calculations and then save them as part of your data source. These fields are called calculated fields.
For more information on calculated fields, see Create Custom Fields with Calculations. Sets – Subsets of data that you define. Sets are custom fields based on
existing dimensions and criteria that you specify. For more information, see Create Sets.
Named sets from an MS Analysis Services server or from a Teradata OLAP connector also appear in Tableau in this area of the Data pane. You can interact with
these named sets in the same way you interact with other custom sets in Tableau.
Parameters – Values that can be used as placeholders in formulas, or replace constant values in calculated fields and filters. For more information, see Create
Parameters. Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_understanddatawindow.htm

NEW QUESTION 271
You need to create a calculation that returns a customer name followed by a comma, a space, and then the customer's age (for example: John Doe, 32).
What should you include in the calculation?

A. [Customer Name] + "," + "STR[Age]''
B. STR([Customer Name]) + "," STR(‘’Age")
C. "Customer Name," + [Age]
D. [Customer Name] + "," + STR([Age])

Answer: D

Explanation: 
 According to the Tableau Desktop Specialist Exam Readiness, to create a calculation that returns a customer name followed by a comma, a space, and then the
customer’s age, you should use the formula [Customer Name] + “,” + STR([Age]). This is because you need to concatenate strings using the + operator, and
convert the numeric field [Age] to a string using the STR() function.

NEW QUESTION 273
What statement correctly describes a requirement to create a reference line in Tableau?
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A. One of the axis must contain a dimension.
B. One of the axis must contain an aggregated measure.
C. The reference line must be created on a continuous axis.
D. The reference line must be paired with a date field.

Answer: B

Explanation: 
 In Tableau, to create a reference line, one of the axes in the view must contain an aggregated measure. Reference lines are typically used to add context or
additional information to the data in a view, and they are often based on some form of aggregate such as the average, median, sum, etc., of a measure.

NEW QUESTION 277
What term is used to describe the following picture?

A. Larger image
B. Parameter
C. Set
D. Hierarchy
E. Group

Answer: C

Explanation: 
 When you connect to a data source, Tableau automatically separates date fields into hierarchies so you can easily break down the viz. You can also create your
own custom hierarchies. For example, if you have a set of fields named Region, State, and County, you can create a hierarchy from these fields so that you can
quickly drill down between levels in the viz.
Reference: https://help.tableau.com/current/pro/desktop/en-us/qs_hierarchies.htm

NEW QUESTION 278
Which two options can you use to change the device layout of a dashboard? Choose two.

A. The Dashboard pane
B. The Format menu
C. The Dashboard menu
D. The Layout pane

Answer: AD

Explanation: 
 You can change the device layout of a dashboard by using the Dashboard pane or the Dashboard menu. The Dashboard pane allows you to select a device type
and customize the layout for that device. The Dashboard menu allows you to create a new device layout or copy an existing one. The Format menu and the Layout
pane do not have options for changing the device layout1

NEW QUESTION 280
DOWNLOAD THE DATASET FROM:
https://drive.google.com/drive/folders/1WXzqsrNmXVdmQ- 574wld4InEplyKT8RP?usp=sharing (if you haven't already)
Using the cwurData table, plot a Map to see which country had the Second highest number of patents in the Year 2013?

A. United States
B. France
C. United Kingdom
D. Canada

Answer: B

Explanation: 
 Follow along to get the correct Answer
? Drag Country to the view, and then Patents to the Size Mark on the Marks shelf as follows :
2) But, this isn't all right? We need to focus on the year 2013. This can be done by using the year column as it is (continuous) in the filter shelf, or by converting it to
discrete first and then using it:
* 2.1 As it is (continuous)
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* 2.2 Converting to discrete first & then using it

and then :

3) We can now see that France, with 485 has the 2nd most number of patents for the year 2013

NEW QUESTION 281
To customize links based on the data in your dashboard, you can automatically enter field values as _______ in URLs
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A. parameters
B. sets
C. values
D. inputs

Answer: A

Explanation: 
 A URL action is a hyperlink that points to a web page, file, or other web- based resource outside of Tableau. You can use URL actions to create an email or link to
additional information about your data. To customize links based on your data, you can automatically enter field values as parameters in URLs.
Read more in depth at : https://help.tableau.com/current/pro/desktop/en-us/actions_url.htm

NEW QUESTION 284
Which type of date filter can you use to choose a range of dates based on TODAY ()?

A. Range of dates
B. Relative dates
C. Ending date
D. Starting date

Answer: B

Explanation: 
 The relative date filter can be used to select a range of dates relative to the current date, such as the past month, the current quarter, etc. This filter type
dynamically adjusts the range based on the current system date, making it suitable for use with the TODAY() function.

NEW QUESTION 288
Using the dataset provided, create a crosstab showing the Profit of each Region per Year, then add grand totals to the view. What was the total Profit for Canada
in 2012 and the total Profit for Canada for 2011 through 2014, respectively?

A. 5,129 and 88,872
B. 52,678 and 311,404
C. 1,807 and 34,571
D. 4,888 and 17,817

Answer: D

Explanation: 
 To reach the correct answer, follow these steps:
1) Drag Order Date (Discrete Year) to the Column shelf, and Region to the Row Shelf as shown:

2) Drag Profit to Text in the Marks Shelf as shown:

3) Click on Analysis as shown -> Totals -> SELECT ROW GRAND TOTALS The following will be the final view:

You could also Filter by Region to only Focus on Canada, but that's your choice:
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THEREFORE, 2012 = 4,888
2011 -> 2014 = 17,817

NEW QUESTION 290
Which two types of fields appear blue? Choose two.

A. Continuous measures
B. Discrete measures
C. Continuous dimensions
D. Discrete dimensions

Answer: BD

Explanation: 
 Discrete measures and discrete dimensions appear blue in Tableau. Discrete fields are those that have a finite number of distinct values, such as names,
categories, or dates. Discrete fields are usually used to create headers or labels in the view. Blue fields indicate that the field is discrete. Continuous measures and
continuous dimensions appear green in Tableau. Continuous fields are those that have an infinite range of possible values, such as numbers or ratios. Continuous
fields are usually used to create axes or color gradients in the view. Green fields indicate that the field is continuous1

NEW QUESTION 293
By default, measures placed in a view are aggregated by _____

A. COUNT
B. AVERAGE
C. MEDIAN
D. SUM

Answer: D

Explanation: 
 By default, measures placed in a view are aggregated by SUM, which means that the data for that field in all of the rows is combined. Measures can also be
aggregated as average, median, count, or count distinct.
Reference: https://help.tableau.com/current/pro/desktop/en-us/calculations_aggregation.htm

NEW QUESTION 295
When is an axis created for the visualisation in Tableau?

A. When we drag a measure to the row/column shelf
B. When we drag a dimension to the row/column shelf
C. When we drag a discrete field to the row/column shelf
D. When we drag a continuous field to the row/column shelf

Answer: D

Explanation: 
An Individual Axis in Tableau is obtained by adding a continuous into Rows or Columns Shelf.
Example:
In order to show Individual Axis in Tableau First, we drag and drop the Color from Dimension shelf to Column Shelf. Next, we drag and drop the Sales Amount
from measures shelf to Rows Shelf. Since it is a continuous value, the Sales Amount will be aggregated to default Sum. Once you drag them, following Chart
report will be generated.
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Next, we drag and Drop one more measure value, i.e., Total Product Cost from Measures Region to Rows Shelf. Because it is a Measure value, Total Product
Cost is aggregated to default Sum. From the below screenshot, you can observe that Tableau has created an individual axis for each measure (continuous field).

Reference: https://www.tutorialgateway.org/individual-axis-in-tableau/

NEW QUESTION 296
DOWNLOAD THE DATASET FROM - https://drive.google.com/file/d/1F8L_Rl5B9LAz8RDi- DdjWx3Iv-SgzaBq/view?usp=sharing ( if you haven't already from the
test instructions page! )
How many different countries are present in the dataset?

A. 150
B. 147
C. 140
D. 156

Answer: B

Explanation: 
Explanation
To reach the correct answer, follow these steps:
1) You can simply drag Country to the view, and look at the marks in the bottom left of Tableau Desktop - 147 marks!
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2) Or, you can simply go to Data Source -> Country Tab -> Describe

As you can see, 147 members exist in this Country column!

NEW QUESTION 297
Which of the following situations describe the best reason to use a union?

A. You have two tables with similarly named columns of data that you want to combine.
B. You have two data sets with similar data types for which you want to find only distinct values.
C. You have two tables with differently named columns of data that you want to combine.
D. You have two data sets saved in different formats that you want to unify into a single format.

Answer: A

Explanation: 
 You should use a union when you have two tables with similarly named columns of data that you want to combine. A union is a method for combining data by
appending rows of one table onto another table. The tables that you union must have the same number of fields, the same field names, and the same data types2

NEW QUESTION 298
Which statement accurately describes an extract when the Physical Tables option is selected?

A. Data is limited to only the Top N of data for the connection.
B. All the data is tolled up to the current visible fields.
C. An individual table is created for each physical table in the extract.
D. Data shown in the Data pane is separated based on the table type.

Answer: C

Explanation: 
 When the Physical Tables option is selected for an extract in Tableau, an individual table is created for each physical table in the extract. This means that the
extract will include a separate table for each underlying table in your database, maintaining the database's structure within the extract. This can be useful when you
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need to preserve the original granularity of the data or when working with certain database optimizations.

NEW QUESTION 302
You want to update the font of an entire workbook. What should you use to configure the default fonts?

A. The Formal Font pane
B. The Format Workbook pane
C. Field labels
D. Titles and captions

Answer: B

Explanation: 
 To update the font of an entire workbook in Tableau, you should use the "Format Workbook" pane. This feature allows you to set and modify the default font
settings for the entire workbook, ensuring consistency in font style across all sheets and dashboards. It's a global setting that applies to all visual elements in the
workbook, including titles, captions, axis labels, and other text elements.

NEW QUESTION 303
Which action describes the process for changing a measure so that it automatically aggregates an average instead of a sum?

A. Right-click the field in the Data pane and select Default Properties to change it.
B. Add the field to the view, right-click the axis, and select Format to change it.
C. Right-click the field in the Data pane and select Change Data Type to change it.
D. Right-click and drag the field into the view to change it.

Answer: A

Explanation: 
 To change a measure so that it automatically aggregates as an average instead of a sum, you should right-click the field in the Data pane and select Default
Properties. In the Default Properties menu, you can set the default aggregation for the measure, such as setting it to calculate an average by default when added
to a view.

NEW QUESTION 305
You want to add Custom shapes to your visualisation. Where can you add these new shapes?

A. In Downloads -> My Tableau Repository -> Shapes
B. In My Computer -> C: -> Tableau -> Shapes
C. In Program Files -> Tableau -> Shapes
D. In My Documents -> My Tableau Repository -> Shapes

Answer: D

Explanation: 
Here's how to add image files to your repository:
1) Find image file on the internet. I try to find consistent image formats if I plan to use a set of shapes such as logos or flags.
2) Download the image to your computer.
3) Drag images into your My Documents -> My Tableau repository -> Shapes folder.
4) Open Tableau and your new shapes will automatically be included in your "edit shapes" menu.
Reference: https://www.tableau.com/about/blog/2016/2/how-use-custom-shapes-filters- your-dashboard-50200

NEW QUESTION 309
Tableau will automatically create a hierarchy for which two kinds of data? Choose two.

A. Date & Time
B. Date
C. Geographic
D. String

Answer: AD

Explanation: 
 Tableau will automatically create a hierarchy for date and geographic data. A hierarchy is a way of organizing data into different levels of detail. For example, a
date hierarchy can have year, quarter, month, and day levels. A geographic hierarchy can have country, state, city, and zip code levels. Tableau recognizes date
and geographic data based on their data types and formats, and creates hierarchies for them by default. Tableau does not automatically create hierarchies for date
& time or string data3

NEW QUESTION 313
Which of the following are benefits of using Data Extracts in Tableau?

A. Improved Performance
B. Ability to use the data offline
C. Working with freshest data at all times
D. Faster to work with

Answer: ABD

Explanation: 
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 Extracts are advantageous for several reasons:
1) Supports large data sets: You can create extracts that contain billions of rows of data.
2) Fast to create: If you're working with large data sets, creating and working with extracts can be faster than working with the original data.
3) Help improve performance: When you interact with views that use extract data sources, you generally experience better performance than when interacting with
views based on connections to the original data.
4) Support additional functionality: Extracts allow you to take advantage of Tableau functionality that's not available or supported by the original data, such as the
ability to compute Count Distinct.
5) Provide offline access to your data: Extracts allow you to save and work with the data locally when the original data is not available. For example, when you are
traveling.
To work with the MOST up-do-date data, use a live connection instead! Reference: https://help.tableau.com/current/pro/desktop/en-us/extracting_data.htm

NEW QUESTION 318
The row and column shelves contain ______

A. Pills
B. Grand Totals
C. Filters
D. Parameters

Answer: A

Explanation: 
 We can drag fields from the Data pane to create the structure for your visualizations.
The Columns shelf creates the columns of a table, while the Rows shelf creates the rows of a table. You can place any number of fields on these shelves.
These FIELDS are also referred to as PILLS. See below:

Reference: https://help.tableau.com/current/pro/desktop/en-us/buildmanual_shelves.htm

NEW QUESTION 319
How can you change the Default Aggregation for a measure in Tableau?

A. By changing its properties manually every time we need to use it
B. By right clicking the dimension -> Default properties and choosing Aggregation
C. By right clicking the measure -> Default properties and choosing Aggregation
D. By double clicking on the measure, and then choosing Window -> Default Aggregation

Answer: C

Explanation: 
According to the official Tableau documentation:
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Dimensions don't have aggregation properties, and adding properties manually each time defeats the whole DEFAULT aggregation purpose. Window tab doesn't
have any default aggregation option!
Reference: https://help.tableau.com/current/pro/desktop/en-us/datafields_fieldproperties.htm

NEW QUESTION 322
When you connect to a new data source, all worksheets that previously referred to the original data source now refer to the new data source. If the new data
source does not have the same field names as the original workbook, the fields are marked with an exclamation point.

Which feature helps us fix this issue?

A. Replace References
B. Fix Metadata
C. Renaming
D. Aliases

Answer: A

Explanation: 
 Replace References:
When you successfully connect to a new data source, all worksheets in the workbook that previously referred to the original data source now refer to the new data
source. If the new data source does not have the same field names as the original workbook, the fields become invalid and are marked with an exclamation point .
You can quickly resolve the problem by replacing the field’s references.
For example, say you have a workbook connected to a data source that contains a Customer Name field. Then you edit the data source to point to a new data
source that has all the same data but instead of Customer Name, the field name has been changed to Name. The Customer Name field remains in the Data pane
but is marked as invalid. To make the field valid, you can replace the references, which means you can map the invalid field to a valid field in the new data source
(for example, Customer Name corresponds to Name).
Read more at : https://help.tableau.com/current/pro/desktop/en-us/howto_connect.htm

NEW QUESTION 326
You can use the _____ in Tableau to clean / organise your data.

A. Data cleaner
B. Data manager
C. Data interpreter
D. Data organiser

Answer: C

Explanation: 
 When you track data in Excel spreadsheets, you create them with the human interface in mind. To make your spreadsheets easy to read, you might include things
like titles, stacked headers, notes, maybe empty rows and columns to add white space, and you probably have multiple tabs of data too.
When you want to analyze this data in Tableau, these aesthetically pleasing attributes make it very difficult for Tableau to interpret your data. That’s where Data
Interpreter can help.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/data_interpreter.htm

NEW QUESTION 327
Which of the following options best describe measures?

A. They are categorical, qualitative
B. They are categorical, quantitative
C. They are numerical, qualitative
D. They are numerical, quantitative

Answer: D

Explanation: 
 Data fields are made from the columns in your data source. Each field is automatically assigned a data type (such as integer, string, date), and a role: Discrete
Dimension or Continuous Measure (more common), or Continuous Dimension or Discrete Measure (less common).
Dimensions contain qualitative values (such as names, dates, or geographical data). You can use dimensions to categorize, segment, and reveal the details in
your data. Dimensions affect the level of detail in the view.
Measures contain numeric, quantitative values that you can measure. Measures can be aggregated. When you drag a measure into the view, Tableau applies an
aggregation to that measure (by default).
Reference: https://help.tableau.com/current/pro/desktop/en- us/datafields_typesandroles.htm

NEW QUESTION 329
When working with Excel, text file data, JSON file, .pdf file data, you can use ______ to union files across folders, and worksheets across workbooks. Search is
scoped to the selected connection.

A. Regex Search
B. Union Search
C. Pattern Search
D. Wildcard Search

Answer: D

Explanation: 
You can use Wildcard Search to set up search criteria to automatically include tables in your union. Use the wildcard character, which is an asterisk (*), to match a
sequence or pattern of characters in the Excel workbook and worksheet names, Google Sheets workbook and worksheet names, text file names, JSON file
names, .pdf file names, and database table names.
When working with Excel, text file data, JSON file, .pdf file data, you can also use this method to union files across folders, and worksheets across workbooks.
Search is scoped to the selected connection. The connection and the tables available in a connection are shown on the left pane of the Data source page.
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Reference: https://help.tableau.com/current/pro/desktop/en-us/union.htm

NEW QUESTION 330
What is a Tableau story point?

A. The pane where you set the size of the story
B. A collection of talking points to drive the story
C. An individual sheet or dashboard in the story
D. A collection of sheets arranged in a sequence

Answer: C

Explanation: 
 A Tableau story point is an individual container in a story that holds a sheet or dashboard. It's like a slide in a presentation, and a story is a sequence of these
points that can be used to convey a data narrative, showing how facts are connected and guiding the audience through a sequence of analysis steps.

NEW QUESTION 333
What are two examples of a date value? Choose two.
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A. 2020-05-01
B. December
C. Wednesday
D. January 1.1995

Answer: AD

Explanation: 
 Date values in Tableau represent specific points in time and are typically formatted in a standard date format.
? Option A, "2020-05-01", is a standard date format representing the 1st of May, 2020.
? Option D, "January 1, 1995", is another example of a date value, representing the 1st of January, 1995. Options B ("December") and C ("Wednesday") represent
a month and a day of the week, respectively, but do not specify a particular date.

NEW QUESTION 337
To display data that has both negative and positive quantitative values, Tableau Desktop will display marks by using ______ as the default.

A. the full color range
B. a diverging palette
C. a sequential palette
D. a categorical palette

Answer: B

Explanation: 
 Tableau Desktop will display marks by using a diverging palette as the default to display data that has both negative and positive quantitative values. A diverging
palette is a type of color palette that uses two different color ranges to show positive and negative values. For example, a red-green diverging palette uses shades
of red for negative values and shades of green for positive values. A diverging palette is automatically applied when there are both negative and positive values for
a measure that is placed on Color on the Marks card5 The other options are not correct types of color palettes that Tableau Desktop uses as the default for data
with both negative and positive values. A full color range is not a valid term for a color palette in Tableau. A sequential palette is a type of color palette that uses
different shades of one color to show variations in a single measure. A sequential palette is usually applied when there are only positive values for a measure that
is placed on Color on the Marks card5 A categorical palette is a type of color palette that uses different colors to show discrete values or categories. A categorical
palette is usually applied when there is a dimension that is placed on Color on the Marks card5

NEW QUESTION 342
......
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